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Overview

This brief provides configuration and implementation information on the integration of HxGN EAM
with AcceleratorKMS (AKMS). HxGN Databridge Pro is the middleware solution that is used to
support the exchange of data between the two solutions.

In addition, this brief describes the configuration requirements and the setup instructions within
AKMS, EAM and Dataflow Studio (a component of Databridge Pro) to complete the configuration.
This brief is intended to supplement the documentation of this feature. It is not comprehensive and
may not include all the details about this functionality.

Intended audience

This brief is intended primarily for system administrators, implementation consultants, and product
architects.
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Overview

Overview

HxGN EAM has incorporated features within the product to facilitate the integration with the
AcceleratorKMS (AKMS) application, another Hexagon product. AKMS is a knowledge management
system built with process industries in mind. This solution doesn't only store your documents, it lets
you easily manage and govern the critical operational content your field workers use every day. This
integration should bring about easier designing of policies and activities into EAM. HxGN Databridge
Pro is utilized to assist with many of the data interactions between AKMS and EAM for this
integration. The diagram below illustrates the order in which the three systems interact.

—

< ——

3. Atfter linking AKMS Content in EAM, users
initiate creation of AKMS Completions.

(Ongoing: EAM users initiate accessing Content
and Completion records in AKMS itself.)

2. Databridge Pro pushes initial
Content data into EAM (with
minor data transformation).

Databridge
Pro

1 . Databridge Pro initiates
search for relevant Content
data in AKMS.

(Ongoing: Databridge Pro pushes
new and updated Content and
updated Completions into EAM.)

(Ongoing: Databridge Pro
searches for new and updated
Content and Completions.)

Databridge Pro initially retrieves information about AKMS Content (including procedures) and
pushes it into EAM. It also continually checks for updates in AKMS regarding Content and EAM
initiated Completions and updates the references in EAM to maintain synchronization. Wherever
EAM users initiate a new AKMS Completion (possible in most Checklist tabs/screens and all the
Documents List tabs), it is done directly with AKMS, not facilitated by Databridge Pro.

Both types of AKMS data (Content and Completions) are leveraged within the pre-existing
Documents entity of EAM. All areas of EAM where you can view documents were updated to ensure
user is taken to AKMS itself when attempting to view AKMS related Documents which users might
associate. In addition, most Checklist tabs and screens are enhanced with fields supporting this
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Overview

feature, as this is a logical placement to ensure that procedural AKMS Content is executed with
AKMS Completion creation.
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Design Assumptions

Design Assumptions

Personal AKMS Credentials

When a user attempts to view AKMS Content or Completion documents in EAM, a new window is
opened to direct user to the record in the AKMS application. If the user is not already logged in with
an active session, they will be required to authenticate using their personal AKMS credentials.

Multiple AKMS Systems Support

In some situations, an EAM system may require using data from multiple AKMS systems. This is
supported by allowing different AKMS systems at the Organization level in EAM and facilitated by
AKMS connection information being set in the Options tab of the EAM Organization screen.

There are a variety of ways to map the data from the AKMS system(s) to EAM Organizations.

One AKMS system to one organization in EAM (like * organization).
One AKMS system to multiple organizations in EAM, while ensuring the AKMS system data

is segregated across the organizations to avoid duplicate record errors during processing.
For instance, use the Domain property in AKMS to segregate; only push Domain1

Content data into ORG1 of EAM, and Domain2 Content data into ORG2.

Multiple AKMS systems, each pointing to one or more organizations in EAM.
If any one of the AKMS systems points to more than one organization in EAM, as

above, data segregation would be required to avoid duplicate record errors.

o

L]
O
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AKMS

The following section summarizes basic configuration requirements in AKMS for this integration.
These steps assume that there is just one AKMS system being utilized for the integration of a single
EAM system. If more than one AKMS system is utilized, these activities will need to be carried out in
each one.

Note: To facilitate this integration, AKMS has not been updated in any way. Pre-existing APIs were
utilized.

URL

1. Establish the AKMS system URL to be used for the integration.
2. Make a note this URL for later use in the setup steps.

a. For example: https://dev.acceleratorkms.com/TestCorp

APl Users

This integration requires two API users that need to be administered from AKMS.

e One API user that is dedicated for HXGN EAM application. This API user requires the
necessary permissions to be able to create completions in the AKMS application.

e A second API user, dedicated specifically for Databridge Pro. This API User will be used to
make content and completion search calls.

Both API users need to have appropriate Domain\Role settings which will allow the actions
described for the Content intended to be used for the integration.

Note : The API credentials (i.e. User IDs and passwords) are required to complete the setup in both
EAM and Databridge Pro.
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Personal Credentials

Resuming Completions - EAM users that will be using the integration with AKMS to initiate
new completions and complete them in AKMS will need to ensure their personal AKMS
credentials are set up to have appropriate Domain\Role settings. The settings must allow the
user(s) to resume completions initiated in EAM by utilizing the Join option in AKMS. The
AKMS API user created for EAM to use and assigned in the AKMSUSER Org. Option will
always be automatically assigned to the Completions initiated in EAM, but it is expected that
different individual users will resume or be assigned to those completions. See more
information in the AKMS Help describing the need for these users to have a role assigned
which includes the Complete Content operation.

Viewing Content and Completions — EAM users that will be using the integration to just
view Content and/or Completions will also need to have appropriate Domain\Role settings
assigned to their personal AKMS credentials for that purpose.

Assigning Users to Completions — For EAM users that will be using the integration to
initiate new completions and assign other AKMS users (using the Manage feature in AKMS)
for carrying out the steps to completion: the same guidelines above apply for these other
AKMS users, and the EAM user who initiated the completion will need appropriate settings
assigned to their personal AKMS credentials to utilize the Manage feature in AKMS.

Security Timeout Value

It is recommended that the SecurityTimeoutMinutes value in the AKMS Configuration screen to be
no less than 20 minutes.
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EAM

EAM

This section is focused on the configuration activities within the EAM application and the impacts to
its various screens.

Configuring EAM

This section describes the steps which need to occur in EAM to fully utilize the integration. Some
activities are optional and described as such.

Note: Navigation to the screens is not described as it may be different in your menus. If unsure
where to locate, you may utilize the handy Jump to Screen feature which can be launched with
CTRL+F2 and the screen codes provided in parentheses within this section.

Note: As best practice, system delivered Dataspies and Screen Designer settings should only be
updated by a system administrator to ensure integrity of the data being used.

User Setup Screen

An EAM API user is required to authenticate and authorize Databridge Pro access to a HXGN EAM
tenant. The following steps are required to complete this setup

1. Create a user on the User Setup screen (BSUSER). The user should be administered
against the appropriate group that has administrative privileges to HXxGN EAM Documents.

2. For this setup it is required that the language setting for the API User is equivalent to the
DEFLANG parameter of EAM. E.g. EN for English. Select the user’'s language setting in the
language field.

It is also required that the system DEFLANG is the same default system language system
settings as AKMS. This ensures that both systems are integrating metadata in a common
language. Multiple language translations against the integrated meta data are supported and
is described in the Adding and Removing Language Translations section.

3. The APl user should have access to the organization where AKMS Document content data
needs to be created and updated. For example, the “** Common organization. Navigate to

%

the Organization tab and administer the appropriate organization such as .
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Note: If more than one organization will be targeted for holding AKMS Content data,
associations for each organization should be made. (Multiple EAM API users are not
necessary.)

4. In addition, the API user should have the Connector check box selected, which allows the
user to make API calls.

Integration Configuration Screen

Databridge Pro will use the EAM API user to make REST API calls. For authentication, an API Key
is required to authenticate the EAM API user with the HXGN EAM tenant.

1. Navigate to the Integration Configuration screen (Screen Code: BSIGCC). On the record
view tab of this screen, select the Application Name as EAM API. This will default the
selection for Grant type to Client Credentials with the Active checkbox checked.

Note: If the EAM API application entry was previously created. The Grant type would have had
the value of Authenication. For the purpose of this integration, this value would not impact the
steps required for generating an api keys in the APl Key Management tab.

2. Navigate to the APl Key Management tab and in the User ID field, select the EAM API user
created in the User Setup Screen section. Save the record.

a. Focus on the saved record and generate the API Key using the Generate API Key
option in the Actions menu. The system will popup a message with the generated
API Key.

IMPORTANT: Copy this key and save it to a secured location. This key is only shown once
by EAM. The API Key will later be used to configure Dataflow studio processors.

Organization Screen

The Options tab on the Organizations screen (BSORGS) will need to have appropriate AKMS URL
and credential data populated for the organization(s) which will hold the AKMS related documents.

As described earlier, there are several options available for mapping the AKMS data to organizations
in one EAM system.

e One AKMS system to one organization in EAM (like * organization).
One AKMS system to multiple organizations in EAM, while ensuring the AKMS system data
is segregated across the organizations to avoid duplicate record errors during processing.
o Forinstance, use the Domain property in AKMS to segregate; only push Domain1
Content data into ORG1 of EAM, and Domain2 Content data into ORG2.
e Multiple AKMS systems, each pointing to one or more organizations in EAM.
o If any one of the AKMS systems points to more than one organization in EAM, as
above, data segregation would be required to avoid duplicate record errors.

When providing the three Org. Option values listed below, utilize the information collected in the
earlier setup section for AKMS.
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You will need to provide values for three records found in the Options tab of the Organizations
screen. See list below along with details and/or advice for each.

e Option 1 - AKMSURL
o For viewing Content and viewing/creating Completions.
o Sample: https://acme.acceleratorkms.com/acme

o Note: If this value needs to be changed to a new valid value when the old
original URL value is also still valid, it is recommended that you do one of the
following:

- Notify users when making this change to not attempt to start/create a
completion for the next 20 minutes to ensure any token which exists
(using the old original URL value) expires.

- Implement changes in off-hours when users would not be using the
Start/View AKMS Completion feature.

e Option 2 - AKMSUSER
o Used only for Completion creation.

o Ensure user has appropriate domain/role abilities in AKMS for creation
completion. This would be the AKMS API user created for EAM’s use and saved
aside in prior AKMS section.

o EAM will be accessing AKMS for Completion creation using bearer token
password grant type. The token expires after 20 minutes. If a token request had
been successful during the Completion creation process using the value in this
field and it is not expired yet, the system will continue to use the token for the
Organization for up to 20 minutes. It would need to expire before the system
uses any new value which might be provided for AKMSUSER. See more detail
on the tokenization process in the Documents List tabs section.

e Option 3 - AKMSPWD

o Password value corresponding to the user value given for AKMSUSER option.

o Used only for Completion creation.
o Encrypted on save.

o If the APl user in AKMS created for EAM is a standard account, be sure to
update this AKMSPWD Org. Option whenever periodic required password
resets are carried out in AKMS. This also applies if a service account is used
instead, but password resets are not typically required for the service user
accounts.

Documents Screen

1. Databridge Pro uses EAM Grid API calls to navigate and obtain EAM data leveraging the
system delivered ‘AKMS Documents’ dataspy. On the BSDOCU List view, select the ‘AKMS
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Documents’ dataspy, and edit the dataspy to include the following additional EAM fields and
save the dataspy.

¢ AKMS Date Updated

The AKMS Date Updated field is used by Databridge Pro in addition to other AKMS Fields to
synchronize documents between AKMS and EAM.

Note: The next step and the remaining steps in the EAM configuration sections are not required but
should be considered to fully utilize the changes implemented for this integration.

2. Using Screen Designer mode, consider the following steps to surface protected fields related
to AKMS on the Record View tab of the Documents screen (BSDOCU).

a) Unhide the External System Details block itself.

b) Unhide these protected fields within this block beginning as AKMS if/as desired:
i. AKMS Type
i. AKMS GUID
iii.  AKMS Domain
iv.  AKMS Status
v.  AKMS Completion Number
vi.  AKMS Parent
vii.  AKMS Completed Date
vii.  AKMS Cancelled Date
ix.  AKMS Created By
X.  AKMS Date Created
xi.  AKMS Updated By
xii.  AKMS Date Updated

Task Plan Screen

Per your organization’s needs, use Screen Designer mode within the Checklist tab of the Task Plans
screen (WSTASK) and consider unhiding the following fields:

1. AKMS Content
2. AKMS Content Description
3. AKMS Completion Required
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Various Operational Screens

In the following operational screens/tabs, consider which are used by your organization and whether
you could leverage using the integration with AKMS via use of AKMS fields in Task Plan Checklists.
If yes, the Dataspy(ies) for each will need to be updated in the Layout tab to pull in the three AKMS
fields if/as desired:

1. AKMS Content
2. AKMS Content Description
3. AKMS Completion Required

Screen Name (and tab) Screen Code
Work Orders | Checklist tab WSJOBS *
Permit to Work | Checklist tab WSPMTW
Case Management | Checklist tab CSCASE *
Case Management Tasks | Checklist tab CSCMTK *
Nonconformities | Checklist tab OSNCHD
Nonconformities Observations | Checklist tab OSNCFM
Assets | Checklists tab OSOBJA *
Positions | Checklists tab OSOBJP *
Systems | Checklists tab OSOBJS *
Locations | Checklists tab OSOBJL *
Operator Checklist WSOPCL
Review Operator Checklist WSOPCK
Contractor Portal | Checklist tab WSCOPO

* - These screens should also be considered for additional updates to their Documents

List tab as outlined in next section.

To better track the status of any AKMS Completion document a user might create/link to a checklist
item, you should consider adding the AKMS Status field (or other AKMS related fields as desired) to
the dataspy of the shared popup list grid invoked in any of the above screens/tabs via ‘Add/Edit
Checklist Item Documents’.
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Documents List tabs

The Documents List tab is offered in 8 screens (listed below). In each of these screens, this tab will
offer the ability to link AKMS Content documents and AKMS Completion documents can be
started/linked against them as well if/as needed. (Starting AKMS Completions from EAM is
described in full later in this brief.)

1. Work Orders (WSJOBS)

Purchase Orders (PSPORD)

Case Management (CSCASE)

Case Management Tasks (CSCMTK)
Assets (OSOBJA)

Positions (OSOBJP)

Systems (OSOBJS)

8. Locations (OSOBJL)

If you anticipate creating AKMS Completions in the Documents Lists tab of any of the above screens
you should consider updating the dataspy(ies) where relevant to pull in the AKMS related fields if/as
desired using the Layout tab, especially the ‘AKMS Status’ field.

N o o b~ e b

Areas of Impact in EAM

This section outlines the various screens and tabs which are affected by the integration with AKMS,
some of which are already touched on due to configuration changes outlined in prior section.

Documents screen

o AKMS records (Content and Completions) will appear in the Documents screen.

o Content data (which could include procedures) is extracted from AKMS and brought
into EAM via Databridge Pro processing.

o Completion data is created by EAM itself via processes invoked in other EAM
screens; more details outlined later in this brief.

o Most AKMS Related fields are in the External System Details block, all beginning with
‘AKMS’. Other fields in the Documents screen are also utilized by the integration.

o The fields beginning as AKMS are always protected in the Ul.
o When the ‘AKMS Type’ field has a value, these fields are protected in the UL.

- Description
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- Title

- Revision Number

- Revision Date

- File Type (Not used by integration. Should always be left blank)
- File Path (Not used by integration. Should always be left blank)
- Expiration Date

o See Appendix A - Solution Integration Mapping for the full list of fields and related
comments.

e Updates which occur to these Content and Completion documents within AKMS are detected
via Databridge Pro processes and pushed into EAM, most notably for Completions: the
AKMS Status field, which will flow through statuses such as Not Started, Partially Completed,
and Completed.

o A Dataspy, ‘AKMS Documents’ is delivered with the product dedicated to only showing
AKMS documents and many of the AKMS fields are utilized.

Viewing AKMS related documents

When users attempt to view an AKMS Content or Completion document from within any screen, tab,
or menu option in EAM, the system uses the document’s Organization to locate the value set for the
AKMSURL Org. Option. The system then appends the URL with two elements to launch AKMS in a
new window for the user to view and/or work on the Content or Completion item within AKMS itself.
This may require the user to login to AKMS with their personal AKMS credentials if they don't
already have an active session.

o If AKMS Type = Content (AKMS) then URL is appended with /Content/’ and the GUID:
<AKMSURL Organization Option>/Content/<AKMS GUID value on the document being viewed>
For example:

https://dev.acceleratorkms.com/TestCorp/Content/02db1338-fd44-4b56-a3ce-9c1b8fc9edbd

o If AKMS Type = Completion (AKMC) then URL is appended with ‘/completions/’ and the
GUID:

<AKMSURL Organization Option>/completions/<AKMS GUID value on the document being viewed>

For example:

https://dev.acceleratorkms.com/TestCorp/completions/ee9f430f-016¢c-418¢c-8713-99b0ec971846
This logic will be utilized in all scenarios available for viewing documents as listed below:

o View Document - Relevant throughout the product, and sometimes invoked with
mouse click(s) on a record/line in addition to selection of ‘View Document’ action
item.

=  Documents screen
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=  Documents tabs
=  Documents List tabs

= Document related popups. For example: ‘Add/Edit Checklist Documents’
popup available on Checklist screens/tabs

o Start/View AKMS Completion — relevant in 2 contexts
=  Documents List tabs
= Most all Checklist screens/tabs

o View AKMS Content — relevant only in Checklist screens/tabs

Documents tabs/popups

This section concerns the Documents tab on most all screens of EAM and Document popups where
user can link existing documents.

o User may manually link any pre-existing AKMS Content document pushed into EAM, and
each may be linked more than once.

o AKMS Completions cannot be manually linked; they are hidden in the Lookup. But they may
show up in the Documents tab and popups by use of an Action Link option for Start/View
AKMS Completion initiated in other screens and tabs described later in this brief. Each
Completion will not be linked to more than one record, as can be confirmed in Documents
screen’s Where Used tab.

Documents List tabs

This section concerns the Documents List tab available in a few screens like Work Orders, Purchase
Orders and Case Management Tasks.

e User may manually link any pre-existing AKMS Content document pushed into EAM, and
each may be linked to multiple records.

o Start/View AKMS Completion - User may initiate an AKMS Completion by focusing on an
already linked AKMS Content document in the Document List tab and selecting the Action
Link for Start/View AKMS Completion.

e Launching this results in a new Completion created in AKMS as well as in EAM along
with an association to the current header record in EAM. Even if focused on an
AKMS Content record having Source columns filled in, the new Completion is
associated to the header record, not the source record where the AKMS Content is
associated. For example:

o AKMS-10001 Content document is associated to a
Department record DEPT1
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o DEPT1 is referenced in the Department field of the Assets
screen for BOILER-01 record

o When user navigates to the Documents List tab in the Assets
screen they will see AKMS-10001 Content document with
Source columns filled with Department/DEPT1 values.

o If useris focused on this AKMS-10001 Content document
when selecting Start/View AKMS Completion, the resulting
completion document association is with the BOILER-01
record itself (not associated to the AKMS-10001 document or
the DEPT1 department); and its Source columns will be
empty.

See details of how this is accomplished in the steps below.

1.

EAM looks to see if there is an unexpired token for the Organization of
the focused AKMS Content document. If yes, system skips to step 5.

EAM uses the Organization of the focused AKMS Content document in
EAM to lookup the AKMSURL, AKMSUSER, and AKMSPWD values set
for that Organization.

Next, a token will be requested by EAM using HTTP POST. The API call
is sent to the value in AKMSURL and appended with ‘/token’. The body of
the post sends 3 elements:

Key Value

grant_type password

username <relevant AKMSUSER Org Option value>

password <relevant AKMSPWD Org Option value, decrypted. Not
the encrypted value>

Sample body:

grant type=password&username=EAMAPI USER&password=TT73nvT5

AKMS will send back a token value in the response to EAM. EAM will
keep track of:

a. token value

b. date/time it will expire

c. Organization it was created for

d. AKMSURL it was created against

EAM will then use the token to send a call to create the Completion. It
uses the AKMSURL value from the token data, but appended with
‘api/Completions/Create’ . Besides sending the token value to AKMS,
it will also declare a ‘ContentID’ value which is the AKMS GUID value
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from the focused AKMS Content document. In addition, a contextual
reference about the EAM record where the Completion will be associated
is declared with a ‘WorkOrderNumber(Optional) value.

= Note: the token value will be re-used for up to 20 minutes at which
time it expires. If any EAM user tries creating a new completion for
the same Organization before that time is up, then the earlier token
request steps 2 - 4 are skipped.

6. AKMS will send back a response with information about the new
completion it created.

7. EAM will use that response data to assist with some of the data fields
when it creates its related AKMS Completion Document in EAM and
associates it to the header record. (The synchronization processes of
Databridge Pro will continue to update this record further.)

e The name assigned to the new Completion document will begin
with the name of the AKMS Content document in focus when
creating the Completion followed by an auto-incremented integer.
For instance, if focused on content document named ‘AKMS-
10022’ and there is no Completion in EAM yet for this document,
it will be named ‘AKMS-10022-1'. If any user creates another
completion against AKMS-10022 later on, it will be given a name
of AKMS-10022-2, and so on.

e See more details about the AKMS Completion fields in Appendix
A — Solution Integration Mapping.

o System also launches a new window for user to view and work on the new
Completion record in the AKMS application itself.

o When viewing the Completion in AKMS, user will see that there is a
contextual reference in the Work Order field starting as EAM_CMP. It is
followed by Entity Codes (user and system), Entity ID, and Organization
Code information. Note that AKMS only has this one reference field (Work
Order), so it may contain a reference to entities in EAM other than work
order, as when invoked while on the Documents List tab for BOILER-001 in
the Assets screen, it would contain a value like: EAM_CMP OBJ (OBJ) —
BOILER-001 (ORG1)

o Note: To see the newly created/associated Completion in EAM, user must
refresh/run the Dataspy.

Note: If a completion already exists and is associated to current record, system will only
launch the AKMS application window and take user to the pre-existing Completion.

Reminder: As mentioned in AKMS section, ensure the personal credentials of AKMS users
have been setup to be allowed to resume completions of another user via the Join option in
AKMS.
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Task Plan screen \ Checklist tab

In the Checklist tab of the Task Plan screen, three related fields are on the checklist item:
e AKMS Content — lookup (optional)
e AKSM Content Description — (protected)

o AKMS Completion Required — checkbox (optional, but can’t be selected if AKMS Content is
empty)

The selections for these fields will impact operational screens downstream where these fields will be
available as read-only.

Operational Screens having Checklist items

The main operational checklist related screens/tabs where changes are introduced for AKMS
integration are listed below:

e Work Orders \ Checklist tab
e Permit to Work \ Checklist tab
e Case Management \ Checklist tab
e Case Management Tasks \ Checklist tab
¢ Nonconformities \ Checklist tab
e Nonconformity Observations \ Checklist tab
e Operator Checklist
o Review Operator Checklist
e Contractor Portal \ Checklist tab
The following features are implemented for these screens/tabs:

1. Fields: Three read-only fields are on checklist items for the above screens and get
populated by the values set on checklist items of the related Task Plan record at the time the
operational record was created:

e AKMS Content
e AKMS Content Description
e AKMS Completion Required
2. Action Link for View AKMS Content

e Ifinvoked when focused on a checklist item having a value in the AKMS Content field,
EAM launches a new window to view the content in the AKMS application.

3. Action Link for Start/View AKMS Completion
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o Ifinvoked when focused on a checklist item having a value in AKMS Content field,
system behaves as described earlier for Documents List tabs:

o EAM will create a new Completion record in AKMS and in EAM along with an
association to the current checklist item.

o The system also launches a new window for user to view and work on the new
Completion record in the AKMS application.

o If a completion already exists and is associated to current checklist item, instead
of creating a new completion, system will only launch the AKMS application
window and take user to the existing completion.

e But there are a few differences when dealing with this action in the Checklist context vs
when in a Documents List tab:

o In EAM side, the new Completion document can be seen in a Documents popup
by clicking the Add/Edit Checklist tem Documents Action Link while focused
on the checklist item.

o The contextual reference logged in the Work Order field of the Completion in
AKMS which begins as ‘EAM_CMP’ will always have a system entity code
ending with CL (for checklist), and the Entity ID will be the Checklist Item 1D
value, not the ID of the Header record.

= For example:

e when Completion is initiated from a checklist item on Work Order
(ID 10015) having a checklist Item ID of 10066, it would contain a
value like:

o EAM_CMP WACL (WACL) - 10066 (ORG1)

e Similarly, when initiated from a checklist item on a Permit to Work
record (ID 10003) having checklist Item ID of 10022, it would
contain a value like:

o EAM_CMP PWCL (PWCL) - 10022 (ORG1)

Validation: If a checklist item exists where the AKMS Completion Required checkbox is
selected but there is no related AKMS Completion with AKMS Status equal to completed,
then you cannot close the work order or the permit to work for example.

Note: Remember, to avoid this error you must:
1) Ensure the Completion is updated in AKMS itself to a Status of Completed.

2) Ensure that the processors in Databridge Pro which search for Completion
updates from AKMS and send them to EAM are activated and there are no
processor errors.

In addition, the Checklists tab on the four Equipment screens are impacted as above but without the
Start/View AKMS Completion and Validation functionality. These screens have additional columns
(AKMS Content, AKMS Content Description and AKMS Completion Required) and the View AKMS
Content Action Link.
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o Assets \ Checklists tab
o Positions \ Checklists tab
o Systems\ Checklists tab

o Locations \ Checklists tab

HxGN EAM Digital Work

Various equivalent screens within Digital Work (EAM’s powerful mobile connected platform) were
also updated to ensure the same AKMS related abilities described above are available.

Limitations

The following screens have no AKMS support:

e The View Checklist Items action link from either the Operator Checklist or the Work Order
Checklist tab of the Equipment screens (Assets/Systems/Positions/Locations)

e The Checklists tab for the Job Plans screen
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Databridge Pro

This section describes the actions to prepare and deploy the necessary components of Databridge
Pro for the integration between EAM and AKMS.

Configuring Dataflow Studio

The following diagram illustrates the integration and data flow between EAM and AKMS.

AKMS / EAM Integration — High Level

Databridge Pro AKMS

.-:'f'l
HxGN EAM is (N([h)ﬂogul\qz;;sata) <tooo-oooot{noaloaonontouo
the system of Synchronize Content Metadata AKMS is the

record for: - system of
Link Documents AKMS record for:
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Completion Number, Status,

The integration of EAM and AKMS, is architected and deployed with the concept of AKMS as the
system of record for an organizations procedures and completions. Completions are crucial for
maintaining an audit trail, tracking progress, and ensuring compliance with regulatory requirements.
They help in identifying who made changes, what changes were made and when they occurred,
thereby providing transparency and accountability in the management of procedures.
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HxGN EAM enforces the compliance of various operational procedures against assets, specific
work, maintenance and case management tasks to be completed.

AKMS procedure records in HXGN EAM are linked to task oriented activities such as work orders
and checklists, which then allows the user to jump directly to the procedure in the AKMS application
and view it. This linkage also allows the user to create a completion in AKMS from HxGN EAM to
then follow and acknowledge the steps required to finish the document.

Databridge Pro is the middleware solution that enables the integration between HXGN EAM and
AKMS. It synchronizes AKMS content metadata and completion status by domain with HXGN EAM
organization documents. This furher enables users to search and cross reference AKMS procedures
and completions from within HXGN EAM and maintains procedure version control with AKMS.

Dataflow Studio, a component of Databridge Pro, is a cloud web-based graphical Ul where you
design, configure, and monitor dataflows between any applications. For an in depth overview of
Dataflow Studio, refer to the HXxGN Databridge Pro brief.

Appendix A — Solution Integration Mapping provides a complete field list and mapping of the
integration.

Dataflow Studio Flow Definitions

Dataflow Studio supports the ability to create, download, and import flow definitions. Flow definitions
offer a way to share flow configurations for enhanced consistency and implementation between
Databridge Pro environments.

The pipeline for synchronizing AKMS Content and Completion status to EAM has been delivered in
a flow definition. The flow definition is available in the Smart Community Developer Portal. The flow
definition is grouped into a single overall processor group called AKMS to EAM and configured for a
1:1 pairing between an HXGN EAM organization to an associated AKMS Domain.

Processor groups in Dataflow studio allow you to group related processes and their connections
together for better flow management. It provides a way to manage the scope of dataflows and isolate
them from other processor groups. This allows you to set different timed frequencies to when
integrations should occur. Processor groups can also be nested to further break down and group the
data processing logic.

For each AKMS Domain that needs to be integrated, a copy of the AKMS to EAM processor group
needs to be created, named and configured appropriately to reflect the appropriate organization and
domain pairing.

For example, an organization ACME has a single AKMS system with three AKMS Domains defined.
Each domain corresponds to a particular ACME operating location, i.e. Houston TX, Duluth, GA,
Seattle, WA. The requirements are to integrate content data from the Houston and Duluth domains
into ACME’s HXGN EAM solution. HXGN EAM has been configured with a single organization,
named ACME.

To facilitate this integration, a processor group definition for the respective locations with HXGN EAM
will need to be created. A processor group file that supports the integration between ACME
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organization in EAM and the AKMS Houston, TX domain and another between the ACME
organization in EAM and the AKMS Duluth, GA domain.

Alternatively, if the requirement was to integrate all domain content of ACME, the option to map the
ACME EAM organization with the entire AKMS global domain is also possible. This would be the
best method if there was no need to integrate domain specific content in AKMS.

Importing Flow Definition

From the Smart Community Developer Portal, download the AKMS to EAM.json flow file definition
and perform the following steps.

1. Import the AKMS to EAM.json flow file into Dataflow studio by drag and dropping the
processor group icon onto the canvas from the component toolbar.

2. In the Process Group dialog box, click the Browse button. Select the flow definition to import
from your local directory. The Processor Group name will default as the flow definition name.
After selection of the flow definition, the Process Group Name can be edited at this step.

Select the AKMS to EAM.json flow file to be imported from the file browser.
Click Add.

Dataflow Use Cases

The data flow between AKMS and EAM is comprised of two major flows. The content flow and the
completion flow. The Databridge Pro template defines these as follows:

Content Data Flow

This flow has two use case options. These are defined as follows:

Use Case 1: Synchronize all published content from AKMS. This flow is to be chosen in the case
when all published content from AKMS is to be integrated with HXGN EAM. It is initiated with the
GenerateFlowFile processor named Complete Content Sync by Domain.

Use Case 2: Synchronize a subset of published content from AKMS. This flow is to be
considered in the case where only a subset of published content from AKMS needs to be
integrated with HXGN EAM. AKMS offers the ability to filter out published content based on a
predefined date. For Example — Synchronizing all published content post Jan 1, 2022. It is
initiated with the GenerateFlowFile processor named Content Sync by Domain and Date.

IMPORTANT: Only One of these two use case flows need to be configured and activated for this
integration.
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Completion Data Flow

The completion data flow has only one option and that is the last use case and required to be
configured and activated for the integration. This is defined as use case 3 in the template:

Use Case 3: Synchronize completion status from AKMS. This flow synchronizes the status of
completions created from HxGN EAM with the updated status of completions in AKMS. It is
initiated by the GenerateFlowFile processor named Full Sync by Domain Completions.

Configure Parameter Contexts

Parameter contexts are a feature that is used to centralize and manage configuration values called
parameters. Parameters can be reused across multiple processors, controller services and other
components. It is essentially a container of key-value pairs. The following key value pairs need to be
created in AKMS to EAM processor group.

1. Select the upper right main menu in Data flow studio and select the option for Parameter contexts.

2. Select (+) to add a new Parameter Context. Enter AKMS To EAM as the name and enter a brief
description for this context.

3. Select the Parameters tab and using the (+) add the following parameters shown below with the
appropriate values specific to your environment in the Values text box. Select the option of the value
as sensitive as indicated in the table below.

NOTE: The parameter values are case sensitive.

Parameter Name Description Sensitive
Value

EAMOrg EAM organization
EAMTenant Tenant name of the EAM environment
EAMURL EAM rest services URL
EAMUsername EAM APl username
x-api-key EAM API key value Yes
AKMSStatus Status of the Content Documents from

AKMS. Set as “Published”, “Archived”
AKMSUTrl AKMS environment URL
AKMSTokenAuth AKMS rest service URL for the

authentication token, usually in the

format:

https://AcceleratorKMS URL/token
AKMSUsername AKMS APl Username
AKMSPassword AKMS Password of AKMSUsername Yes
Domainld AKMS Domain GUID from which to

synchronize the content metadata
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Parameter Name Description Sensitive
Value
ModifiedStartDateCustom AKMS Modified Date used to filter
synchronization of content. Valid only
if using Use Case 2
emailServer SMTP server to authenticate and send
emails from Log Messages
emailsFrom Sender's email address
emailsTo Email of recipients for log message
emails
SMTPUsername Username for email authentication
SMTPPassword Password for email Yes
authentication

4. Once all the parameters are added, click the Apply button to verify the configuration. A successful
verification is indicated by the green check marks on the left and warning icons to the right of the

panel, which shows the list of referencing components. Below is an example of a failed

verification, where the warning icons are reflected against the specific processors. To fix the errors,
hover the warning icon to understand the error being reported. Navigate back to the parameter
context menu and select the AKMS_TO_EAM parameter context to make corrections. Repeat as
necessary until all warnings are cleared.

Update Parameter Context

Steps To Update Parameters

Stopping Affected Processors
Disabling Affected Controller Services
Updating Parameter Context

Restarting Affected Processors

Re-Enabling Affected Controller Services w Create Document

Parameter
EAMTenant, EAMURL

Referencing Components @

Referencing Processors
Add Document to EAM

Referencing Controller Services

Unauthorized Referencing Components

w Create EAM Language Translations
Referencing Processors
Add EAM Translation

Referencing Controller Services

Unauthorized Referencing Components
v
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Enable Controller Services

Controller services in Dataflow studio are shared resources that can be used by multiple
components within a dataflow. They provide a centralized configuration and offer functionality that
can be leveraged by processors, reporting tasks and other services. Some examples are database
connection pools, SSL context and token services.

A controller service has already been pre-configured for this integration. The parameter details
configured in the previous section will be applied to enable the service.

To enable the controller services, follow the steps below
Steps:

1. From the canvas, Click and select the gear icon (#) from the Operate panel. This action will
launch the controller services tab.

2. Select the AKMSTemplate-StandardOauth2AccessTokenProvider.This service manages
the Oauth 2.0 authentication to obtain access tokens for secure API interactions with AKMS.
The default current token resource limit is set to 20 mins (1199s)

3. Enable the service and referencing components by clicking the (%) icon.

4. Close the configuration.

Configure Content Language Translations

NOTE: If there are no multi-language translations for the content in AKMS, and DEFLANG of EAM is
the same as the default language of AKMS, then this section to configure content language
translations can be omitted, and the Create EAM Language Translations and Update EAM
Language Translations processor groups can be turned off. See Deploying the Integration section

AKMS supports multiple languages, specifically for the content title and description fields across
all documents. In contrast, HXGN EAM only supports multi-language functionality for the description
field.

To enable multi-language support in this integration, the AKMS Title field is mapped to the EAM
Description field.

It is recommended that every translated language in AKMS has a corresponding EAM language
code mapping. For instance, if AKMS content is translated into German, Spanish, and French,
equivalent translations must be mapped using the respective EAM culture codes.

A 1:1 mapping between AKMS and EAM language codes is essential to prevent missing translation
errors during the dataflow process.The table below is an example of the mapping between AKMS
and EAM Culture codes
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Language AKMS Culture Code EAM Culture Code
German de GE
Spanish es ES
French fr CA FR

Adding and Removing Language Translations

The AKMS to EAM flow file definition template includes a set of default mappings for culture codes,
which can be customized based on specific implementation needs.

Language extraction and transformation from AKMS, along with synchronization with EAM
translations, are handled by the Create EAM Language Translation and Update EAM Language
Translations processor groups.

To add a new translated language, you must first add a new property to the Extract AKMS Title
Translation processor. This property should represent the AKMS culture code for the desired
translation and follow a specific value format.

For example, to add Dutch as a translated language, use the AKMS culture code nl. The AKMS
Content Search API provides a list of translated languages for the title and description fields.
Databridge Pro evaluates the JSON payload returned by the AKMS API and extracts the translation
for the Titles key using a JSONPath query. The extracted value is then assigned to nl property in
the Extract AKMS Title translation processor.

For a complete list of supported culture codes refer to Appendix C — AKMS Culture Codes

Steps:

From the canvas, navigate to Sync AKMS Content-> Create/Update EAM Documents->Create
Document->Create EAM Language Translations

The following steps needs to be completed to add a property in the above processor groups based
for the translated content in AKMS

1) Double-click on the Extract AKMS Title Translation processor. Select the properties tab
and Add property icon *

2) In the property name field, enter the new culture code to be added to the extraction process.
Example nl

3) In the value dialog box, enter the json path in the format ${AKMS_Titles:jsonPath('$.X)},
substituting the ‘X’ placeholder as the value of the culture code. Click Ok then Apply to save
the changes.

Below is an example of what the entry would look like for adding Dutch as a property.
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Property Value
nl S{AKMS_Titles:jsonPath('S.nl")}

4) Next, a json object entry needs to be created in the json file, that lists the language culture
code and the associated description value from the AKMS json payload. This file is then
used to build the json translation payload required by the EAM translation api.

From the canvas, navigate to Sync AKMS Content-> Create/Update EAM Documents->
Create Document->Create EAM Language Translations>Build JSON to Transform
Language Objects.

5) Double-click on the Build JSON to Transform Language Objects. Select the properties
tab. Click and expand the value box of the Replacement Value property.

6) Enter the culture code in the following json object format and Click Apply.

"Language” : "X",

"Description” :"${Y:length():le(255):ifElse(${Y:escapeJson()},${Y: substring(0,255):escapeJson()})}"

Substitute the value ‘X* with the EAM culture code and the value of ‘Y’ with the AKMS culture code.
Using the Dutch language example this will be

{
"Language" : "NL",

"Description” : "${nl:length():le(255):ifElse(${nl:escapeJson()}, ${nl:substring(0,255):escapeJson()})}"

TIP- Copy and paste an entry provided by the template and make the edits for culture codes as
instructed.

7) From the canvas, navigate to Sync AKMS Content 2> Create/Update EAM Documents—>
Update Document->Update EAM Language Translations and repeat steps 1-6.

To remove language translations from the default template, simply remove the culture code entry
contained between the brackets { } from both the Extract AKMS Title Translation processor and
Build JSON to Transform Language Objects.
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LogMessage Processors

The LogMessage processor is a component in Dataflow studio that allows you to log details about
data flowing though the dataflow pipeline. This processor is primarily used for debugging,
monitoring, and troubleshooting purposes. Log processors are color coded in red. No configuration
is required for this integration.

Deploying Integration

Initial Data Load of AKMS Content

The initial load of AKMS content data will depend on which use case of the content data flow being
used. Only one of the provided content data flows, Use Case 1 or Use Case 2 will be active for any
deployment.

The default method of loading metadata into EAM, is based on the configured Domainid,
AKMSStatus and the ModifiedStartDateCustom variables. The latter applies only if using Use
Case 2. If no prior AKMS content has been loaded into EAM, it is recommended that only Published
content from AKMS is loaded i.e. Status = ‘Published’. The current default value of AKMSStatus
parameter needs to be modified to receive only Published content for an initial load.

Once an initial load has been completed, the Status parameter needs to be switched back to then
include Archived Content. The entire integration flow can then be started on a defined schedule to
poll AKMS for updates to the content. With the integration active, any previously published document
that is archived by AKMS will be synchronized by the dataflow, as well as any new Published
content will be added by the integration.

The following steps need to be followed to begin an initial load of AKMS Content into EAM.
Steps:

1. Navigate to the AKMS to EAM processor group. From the canvas, navigate to the
Parameter Contexts menu from the canvas and select the AKMS To EAM context

2. Verify the AKMSStatus parameter value is set to “Published”. Apply any changes and
return to the canvas.

3. OPTIONAL - This applies to the situation if you are using Use Case 2. Modify the
ModifiedStartDateCustom parameter value as needed.

4. From the canvas, right-click the Sync AKMS Content processor and select Start. This will
start all the processors within this group. Navigate down the hierarchy of the processor group
to ensure all processors are turned on and no system errors are being reported. If system
errors are identified, stop the processor against which the error message is being reported
by Dataflow Studio and resolve the issue, and restart the processor.
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TIP: You can use right-click against each processor to stop and restart it.

If language translations are not needed, then the Create EAM Language Translation and

Update EAM Language Translations processor groups need to be stopped.

5. Depending on which Use Case data flow is being used, Navigate to the appropriate
GenerateFlowfile Processor. For example, if using Use Case 1, Complete Content Sync by
Domain, Right click on the processor and select the Run Once Option.

This will initiate a one-time flow execution for the dataflow. Observe the flowfiles processing
through the hierarchy and chain of processors via Sync AKMS Content processor group.
Ensure no errors are reported and all the flow files have completed execution.

TIP : You can use the Bulletin Board under Monitoring Menu selection to view any errors in
real time

If errors are reported. Right-click on the canvas to stop the execution to troubleshoot and
resolve the errors. Once the errors have been resolved. Right-click on the canvas to select
Empty all the queues and repeat step 5 to execute the flowfile.

6. Once the flow file has completed executing, verify that the AKMS content metadata has been
loaded into the Document Screen (BSDOCU) of EAM.

TIP: - You can use the AKMS Documents dataspy to view the results

7. This completes the initial loading of content. The integration is now ready to commence at a
defined schedule for synchronization. To prepare for this step, the AKMSStatus value needs
to be modified to include both published and archived values. Navigate tot the AKMSStatus
parameter and edit the value to read “Published”,” Archived”.

NOTE: The above steps need to be conducted for each Domian and org pairing that is configured.
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Synchronization of AKMS with EAM

There are two primary data flows operate independently on a fixed schedule to synchronize data
between AKMS and EAM.

The first is the content data flow, which transfers data from AKMS to EAM and is managed by the
processors in the Sync AKMS Content processor group.

The second is the completion status data flow, also from AKMS to EAM, managed by the
processors in the Sync Completion Status From AKMS group.

The Sync AKMS Content processor group asynchronously polls the AKMS Content Search API to
retrieve all content metadata for a given AKMS domain. The API response is then split into individual
records, each of which is evaluated to extract the required integration fields (refer to Appendix A).

These fields are stored as flow file attributes. The unique identifier for each content record, which is
the AKMS Content GUID, is among these attributes and is used to help construct the JSON payload
for the EAM Grid API.

Each AKMS record is identified by its GUID and compared against EAM to determine whether the
corresponding content already exists.

e If the content does not exist, the data flow is routed to the Create Document sub-processor
group to create a new EAM document using the metadata from AKMS.

e If the content already exists, additional attributes from the AKMS record are used to
compare and update the relevant fields in EAM. These updates, including checks for
available language translations from AKMS, are handled by the Update Document sub-
processor group.

Similarly, the Sync Completion Status from AKMS processor group asynchronously polls the
AKMS Completions API to retrieve all completion records for a specified domain. The API response
is split into individual records, and each one is identified by its AKMS Completion GUID.

Each record is then compared against completion records in EAM where the AKMSStatus field is
not marked as "Completed”. Specifically, the EAM Grid API retrieves records with a status of
‘Queued’, ‘Not Started’, or ‘Partially Completed’. If a matching GUID is found between AKMS and
EAM, the corresponding EAM record is updated with the latest completion status from AKMS.

IMPORTANT - The data flow only updates completion records that were originally created by EAM
in AKMS. Any records created solely within AKMS are excluded from this process.

Define Data Synchronization Schedule

The synchronization of AKMS content is initiated by one of two GenerateFlowFile processors:
Complete Content Sync by Domain or Content Sync by Domain and Date.

By default, these processors are scheduled to run once daily. The exact time of execution is
determined automatically based on when the processor is started.
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The synchronization of AKMS Completions is triggered by the GenerateFlowFile processor named
Full Sync by Domain Completions. By default, this processor is scheduled to poll every five
minutes, with the initial run time determined automatically based on when the processor is started.

IMPORTANT - The minimum allowed polling interval for completions is 30 seconds, as enforced
by the AKMS Completions API. Attempting to poll more frequently will result in an API error.

Modifying the Processor Schedule

You can modify the scheduling configuration of any processor in the data flow. The steps below use
Complete Content Sync by Domain as an example, but the same process applies to other
processors.

Steps:
1. On the canvas, locate the Complete Content Sync by Domain processor.

2. Right click on the processor and select Configure.
Go to the Scheduling tab. Under Scheduling Strategy, choose one of the following:

o Timer Driven — Runs at a regular interval defined in the Run Schedule field (in seconds,
minutes, or days).

e CRON Driven — Runs at specific times based on a CRON expression entered in the Run
Schedule field.
Enter the desired Run Schedule.

4. Click Apply.

Starting the Integration

To start the integration, complete the following steps
To start the integration, follow these steps:

1. Verify that the Sync AKMS Content and Sync Completion Status from AKMS processor
groups are running without errors.

2. If no additional language translations are configured (as explained in the Configure Content
Language Translations section), you can stop the following processor groups to optimize
performance:

e Sync AKMS Content > Create/Update EAM Documents—> Create Document->Create
EAM Language Translations.

e Sync AKMS Content->Create/Update EAM Documents—>Update Document->Update
EAM Language Translations.

To stop them, navigate to each processor group, right-click, and select Stop.
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3. Choose either the Complete Content Sync by Domain or Content Sync by Domain and
Date processor (note: only one should be active at a time). Right-click the chosen processor

and select Start.
4. Right-click the Full Sync by Domain Completions processor and select Start.

The integration data flow is now active and will run according to the configured schedule.

Integration Verification

This section describes how to verify the integration and address issues that may be encountered.

Ensuring Databridge Pro Receives Data

To verify that the Databridge Pro template is receiving data from EAM and AKMS API calls for
synchronization, users can review the data provenance for any processor or use the List Queue
option available in the context menu of connections between processors.

The main processor groups, Sync AKMS Content and Sync Completion Status from AKMS,
consist of multiple processors that route, format, evaluate, and transform the flow file data attributes.
Databridge Pro logs and records details about processor events related to the ingested data within
the flow. This information is stored in the data provenance repository, which can be accessed by
right-clicking any processor and selecting View Data Provenance.

Additionally, the data flow includes built-in email notifications to alert personnel of any errors or
issues that arise during processing.
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Appendix A — Solution Integration Mapping
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EAM Document Field Comments AKMS Content AKMS Completion
API Field API Field
Document (aka Code) Not in AKMS itself. n/a n/a

AKMS Content - EAM automatically
generates a value prefixed with ‘AKMS-*
when creation requests come in via Web
Services having an AKMS Type value and
no document code value is specified.

For example: AKMS-10001

AKMS Completion — EAM assigns this
value as <name of focused AKMS
Content document>-<auto-incremented
integer>

For example: AKMS-10001-1
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EAM Document Field

Comments

AKMS Content

AKMS Completion

API Field API Field
Organization Not in AKMS itself. n/a n/a
AKMS Content: Databridge Pro
configuration must be done to assign an
appropriate Organization value which pre-
exists in EAM system.
AKMS Completion: The organization
value of the focused AKMS Content
document will be used for the organization
value of AKMS Completion documents
when ‘Start/View AKMS Completion’
action link is invoked in EAM.
Description It is notable that the Description value in Title/s Title
EAM is derived from the Title value in (Localized values in
AKMS. Conversely, the Title value in EAM
is derived from the Description value in AKMS ean F)e brought
into EAM with proper
AKMS. . .
configuration/mapping
in Databridge Pro.)
Title Truncated if necessary - EAM supports Description/s Description
4000 characters, but relevant AKMS field
supports 2G. (Localized values in
Itis notable that the Title value in EAMis | AfMo are it
derived from the Description value in EAM.)
AKMS. Conversely, the Description value
in EAM is derived from the Title value in
AKMS.
Type Not in AKMS itself. n/a n/a

‘F’ will be the value assigned for AKMS
documents in EAM, making them not
relevant for Document Repository
Request functionality.
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EAM Document Field Comments AKMS Content AKMS Completion
API Field API Field
Revision Number VersionNumber Version
Revision Date Not in AKMS itself, but EAM detects n/a n/a
change to Revision Number value and
updates this field with current date/time
when it occurs.
Expiration Date ExpiryDate n/a
Created By EAM-only. Not tied to data in AKMS. n/a n/a
Date Created EAM-only. Not tied to data in AKMS. n/a n/a
Updated By EAM-only. Not tied to data in AKMS. n/a n/a
Date Updated EAM-only. Not tied to data in AKMS. n/a n/a
AKMS Type See Appendix B for supported values. n/a n/a
AKMS GUID EAM enforces this value be unique across | !d CompletionID
all Document records.
AKMS Domain Truncated if necessary - EAM supports ClassificationPath ClassificationFullPath

255 characters, but relevant AKMS field
supports 2G

AKMS Status Not governed by EAM Status Status Status
Authorizations.
See Appendix B for supported values.

AKMS Completion Number Used only for Completions. n/a CompletionNumber

(Also utilized as part of the
Document/Code value.)

This value from AKMS is a combination of
Year, Month, and an incremented number
which resets each month. For example:
2025-04-0001
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EAM Document Field Comments AKMS Content AKMS Completion
API Field API Field

AKMS Parent Used only for Completions. n/a Contentld

It will contain the AKMS GUID value of the

relevant AKMS Content record from which

it was initiated.
AKMS Completed Date Used only for Completions. n/a CompletedDate
AKMS Cancelled Date Used only for Completions. n/a CancelledDate
AKMS Created By Not tied to EAM user data. CreatedBy n/a
AKMS Date Created CreatedDate CreatedDate
AKMS Updated By Not tied to EAM user data. ModifiedBy n/a
AKMS Date Updated ModifiedDate n/a
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Appendix B — EAM System Code Entities & Values

Field (Entity Code)

System Code

System Code Description

AKMS Content
AKMS Type (AKTP)
AKMC Completion
QuU Not Started
PCM Partially Completed
CM Completed
CN Cancelled
AKMS Status (AKST)
PUB Published
PPUB Partially Published
EX Expired
AR Archived
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Appendix C — AKMS Culture Codes

For reference below are all the supported AKMS Culture Codes

Culture
Language Code
Arabic ar
Bangla bn-IN
Chinese
(Simplified) zh
Danish da
Dutch nl
English en-CA
French fr-CA
German de
Indonesian id
Japanese ja
Korean ko
Norwegian no
Portuguese pt
Russian ru
Spanish es
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